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1. Introduction

In the institutes where laboratory facilities are not that much available, and industries are
located in remote areas, Personal Computer (PC) can be used to facilitate science and
engineering education. Programming and simulation tools can be used widely for preparing
such a PC based setting for students. But to develop a software, toolbox or standalone
applications one had to rely on C++, Visual basic, or Java. For a computer science or
information technology student it is easy to program in these environments but for other
science and engineering students this pose a problem since they are not familiar with these
programs and require excellent programming expertise. MATLAB (MathWorks, 2009),
flagship software in scientific computing, is extensively used all over the world. Particular
factors that support the selection of MATLAB are:

* A flexible software structure of MATLAB comprising libraries, models, and programs
enables one to integrate different model components in one package conveniently.

* Fast development with MATLAB using powerful calculation and visualization means of
the package enables one to expand the software quickly and efficiently without developing
any extra programming tools.

* A wide selection of TOOLBOXes, comprehensive collections of predefined functions for
solving application-specific problems, is already available with MATLAB and is likely to
grow even faster in the future.

The use of MATLAB (short for MATrix LABoratory) is increasing day by day (McMohan,
2007; Littlefield & Hanselman, 2004). Science and engineering students use this software
broadly for educational purposes (Chapman, 2007). Graphical User Interface (GUI) is an
environment available with renowned software that gives the option to the user developing
software packages for personal and problem specific uses. It is a way of arranging

www.intechopen.com



18 Matlab - Modelling, Programming and Simulations

information on a computer screen that is easy to understand and use because it uses icons,
menus and a mouse rather than only text and programs written in high level language
which is often not much handy for others except for programmers. The rapidly developing
software MATLAB for technical computation is giving two releases per annum with
extended capabilities which enhances user performance and boosts customer satisfaction.
Collaterally, its size is increasing. With every release MATLAB takes a new look with new
features and changes. Each version is accompanied by major bug fixes, enhanced help
menus, removal of undocumented deprecated functions, and development of alternative
functions. In case of GUI this change is more rapid, functions are being obsolete and new
efficient functions are generated. Due to this reason a GUI developed in one version may not
be used in other version (Marchand, 2002; Smith, 2006). So other ways must be taken into
deliberation to solve this setback. This chapter presents a guide to develop standalone
software tools and/or packages using the enormous competence of MATLAB GUI which
can be used in educational and training institutes for learning purposes of freshman or
sophomore students.

But another problem arises simultaneously, the huge size and memory requirements of
these new releases of MATLAB prevents its uses on the PCs having low memory.
Sometimes the programs developed by the recent versions of MATLAB cannot be used by
the previous ones due to lack of version compatibility option. So, although instructors can
develop interactive tutorial packages for students using the recent versions of MATLAB
which they can afford easily, the developed software cannot be used in the laboratories
having older facilities. Students also cannot take the advantage of using the new software
since he does not have the financial capacity of purchasing newer versions or upgrading
MATLAB and high performance PC. To solve this hindrance MATLAB standalone project
development tools can be used.

This chapter describes the development of an interactive computer based GUI for MATLAB
which can be used in any Pentium III graded PC. It has been prepared for anyone who has
little or no exposure to MATLAB. Readers are guided through new concepts to build
easy-to-use GUI, acting as a ‘wrapper’ for experimental simulation codes written by the
educator. Even though the chapter is written based on the recent release of MATLAB 2009a,
this can be used as a guide for other versions starting from MATLAB 6. It is designed to
relieve the coder from most of the programming burden, and to provide with a friendly,
consistent approach to the development of standalone MATLAB programs.

2. Getting Started

MATLAB GUI can be built in two ways.
(a) Using GUIDE (GUI Development Environment)
(b) Coding from MATLAB editor

The first approach of building GUI is straightforward and will be discussed in this chapter.

Once completed several examples of building GUI, anyone can learn how to code from
MATLAB editor.
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To initiate GUIDE let’s write guide in the MATLAB command window and press Enter key.
This will open the GUIDE Quick Start window as shown in Fig. 1, where there are two tabs
(Create NEW GUI and Open Existing GUI). Under the Create New GUI tab four GUI
templates are available. Selecting the Blank GUI (Default) template and pressing Ok at the
bottom of the window opens the design window as shown in Fig. 2.

Bl GUIDE Quick Start ==

Create New GUI | Qpen Existing GUI!

GUIDE templates Preview

) Biank GUI {Default)

4 GULwith Uicontrols

4\ GULwith Sxes and Menu

4\ Modal Question Dialog

BLANK
[ Save new figure as: |Cildsers\nasiruzzamaniDocuments\MATLA Browse
QK I | Cancel | l Help

Fig. 1. GUIDE quick start window

The GUI is not yet saved, so at the top of the window it is shown untitled.fig. Once the work
is saved the title of the GUI will be reflected here. *.fig is the extension of GUI figure files.
Generally, a GUI requires two files the figure (*.fig) files where various components are
aligned and the code (*.m) files where the coding is done. There is also provision to run the
GUI using the single *.m file. At the top of the window Menu and Shortcuts can be found.
To the right there are some GUI controls which are very important to learn for building GUI.
The blank portion is used for the design purpose of the GUI
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3. GUI Components

Some basic GUI components are
a) Push Button

b) Slider

Radio Button
Check Box

Edit Text

Static Text
Pop-up Menu
Listbox

Toggle Button
Table

Axes

Panel

m) Button Group
n) ActiveX Control

e
~

(
(
(
(

&

_
DI

Y
RS2
=

,\,-\,.\A
—
=

N

www.intechopen.com



Using MATLAB to develop standalone
graphical user interface (GUI) software packages for educational purposes 21

These components may vary depending on the version of MATLAB. These examples are
taken from MATLAB 2009a version.

4. A Simple Calculator

The target of this chapter is to give the reader a quick look at GUI of MATLAB rather than
discussing each and every item. Readers will be able to learn with examples. The first
example here will be considered to build a simple calculator. Two numbers provided by
user will be added, subtracted, multiplied, and divided. The result will be displayed in a
box. The first step of building a GUI is to have a rough sketch of the GUI To build a simple
calculator some basic components are needed:

(@) Two input boxes (Edit text)

(b) One output box (Static text)

(c) Four options for addition, subtraction, multiplication, and division (this can be

accomplished in many ways. Here let’s take four Radio Buttons)
(d) One Calculate button (Push Button)

To enhance the GUI one also can add some static texts to show various signs. In this

example two more static texts are used. One is for the sign of calculation (+,-,x,/) and the
other is to show (=) sign. The GUI will look like Fig. 3.

@ ADD

10  + -15
o 2 SUBTRACT

-5
o MULTIPLY

Calculate

= DIVIDE

Fig. 3. A simple calculator

5. Adding Components

Now since the concept of the GUI has been built, the next step is to add all components
required for building the calculators. Adding components to the *fig file is very easy. Just
click the item on the left, drag and drop to the blank space and the component is added.
First consider adding the two static text components for entering two numbers. Select Edit
Text and drag and drop to the blank space of the figure two times. Now the GUI will
somewhat look like Fig. 4.
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Fig. 4. Adding edit text controls to the GUI

Now the newly added editable text boxes must be modified as per the need of the GUL Here
two numbers are added; hence it is a good idea to give two numbers as input from the very
first so the inexperienced user will understand the purpose of the GUI This task can be
performed using Property Inspector.

6. Property Inspector

Now right clicking on the component and selecting the Property Inspector will open the
window as in Fig. 5. The left column gives the property name and the right column shows
property values. String and Tag properties worth emphasizing since it is essential for
programming a GUI The String property has value Edit Text. Anything can be written here.
Lets write 10 here and change the Tag to numberl. Now the property inspector should look
like Fig. 6. Similarly, change the property of the second Edit text. It is changed as: String -15
and Tag number2.

www.intechopen.com



Using MATLAB to develop standalone
graphical user interface (GUI) software packages for educational purposes

HaorizontalAlignment

Interruptible

KeyPressFon
ListboxTop
Max
Min
[# Position

SelectionHighlight
SliderStep
String @
Style
Tag
TooltipString
UIContextMenu
Units

UserData

=28

Walue
Wisible

center

an

10

L0

0.0

[13.4 15.385 10.2 1.692]
on

[0.010.1]

Edit Text

edit

editl

<Mone
characters
[0x0 double array]
[0.0]

an

a

% % % %

Harizontal&lignment

Interruptible
KeyPressFen e
ListboxTop
Max
Min

Pasition
SelectionHighlight

[ SliderStep
String @J
Style
Tag
TooltipString
UIContextMenu
Units
UserData

(=]

Value

Wisible

center

an

10

1.0

0.0

[13.4 15.385 10.2 1.692]
an

[0.010.1]

10

edit

numberl

<Mone>
characters

[0x0 double array]
[0.0]

an

S

B %

Fig. 6. Edited property inspector

www.intechopen.com



24

Matlab - Modelling, Programming and Simulations

7. Aligning Objects

One can align objects in the GUI to make the outlook of the GUI better. It can be done by
clicking Tools menu and then selecting Align Objects. Then using the controls there objects

can be aligned as in Fig. 7.

Dflﬁ untitled.fig

l=le| = |

&)

File  Edit  Wiew Layout Tools

Help

4\ Align Objects

ertical
Align
Distribute

Setspacing |20 pixels

Haorizontal
Align
Distribute

| Set'spacing |20 pixels

e ]3]
ey

QK | | Cancel | |

D EEOERD

=, ot |[e+|[e-, ]
SRR

10 =

Tag: 2 components selected

Current Point: [2, 131]

Pasition: [Multi, Multi, 51, 22]

Fig. 7. Aligning objects

8. Adding More Components

More components can be added to the GUI. In Fig. 8 some Static Text controls are added
and Fig. 9 shows the complete GUI with all components, Radio and Push Buttons are added

here. The property modified for these components are given in Table 1.

Component | FontSize String Tag
Edit Text1 15 10 editl
Edit Textl 15 -15 edit2

Static Textl 15 textl
Static Text2 15 = text2
Static Text3 15 -5 text3
Push Button 15 Calculate pushbuttonl

Radio Buttonl 15 ADD radiobuttonl

Radio Button2 15 SUBTRACT | radiobutton2

Radio Button3 15 MULTIPLY radiobutton3

Radio Button4 15 DIVIDE radiobutton4

Table 1. Properties of various controls used in this chapter
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Fig. 8. Adding static text to GUI
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Fig. 9. Complete figure of a simple calculator
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9. Programming the GUI

Now all the components are added. The GUI is saved in the name fest1.fig. The rest task is
coding the M-file. It can be accessed by clicking M-file Editor from View menu. When the m-
file opens it somewhat looks like Fig. 10. This is a multi-function m-file. Codes are written
under various functions. Functions are generated automatically. The opening function and
callback functions are most important. Functions can be accessed as shown in Fig. 11.

When the GUI is first open the default action will be to work as adder. For this purpose let’s
modify the opening function of the GUI as in Fig. 12.

[} Editor - CAUsersin
File Edit Text Go Cell Tools Debug Desktop Window Help

F_]k'ffﬂ| s BRY f"|'.'§j ’_'-;'-"?'|Mﬁ*ﬁ{|E'@ﬁﬁ%@lﬁﬁ“ﬁck:?éase *
B - [+ ]s[u [x[HKE]0

|function varargout = testl(varargin)

¥

2 |=l% TESTI M-£ile fet testl,fig

3 % TEST1, by itself, creates a mnew TEST1 or raises the existing

4 5 singleton®.

5 %

& 5 H = TEST1 teturns the handle to a new TE3T1 or the handle to

7 % the existing singleton®*.

a %

g % TEST1 (' CALLBACKE' ,hCbiject,eventData,handles,...) calls the local

10 % function named CALLBACE in TEST1.M with the given input argumsnts.
11 %

2 % TEST1|'Property' ;'Value'! ;. ..) creates a new TEST] or raises the

13 % existing singleton®*. Starting from the left, property value pairs are
14 % applied to the GUI before testl OpeningFcon gets called. 4n

L5 % unrecognized property name or invalid walue makes property application
le % stop. All inputs are passed to testl OpeningFen via varargin.

17 %

18 % *3ee GUI Options on GUIDE's Tools menu. Choose "GUI allows only one
19 % instance to run |singleton)”.

20 %

21 -% See also: GUIDE, GUIDATA, GUIHANDLES

22

23 % Edit the above text to modify the response to help tescl

24

2 % Last Modified by GUIDE v2.5 28-May-2010 Z1:0&:35

26

Z % Begin imnitialization code - DO NOT EDIT

28 - gui Singleton = 1;

28— gui State = struct('gui Name', mfilenams,

30 'gui_3Jingleton', gui Jingleton,

31 'gui_OpeningFecn', Etestl_Openinchn,

Fig. 10. M-file for simple calculator
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“f Editor- €

File Edit Text Go Cell Tools Debug Desktop Window Help

Dﬁ-| $BR9 o‘|..§lg ?:?‘|“ﬁ*iﬁ-‘._”E'aﬁﬂ%m@ahtack:[_ﬁi_se__*” It
B -0+ [ 21 (% %2 O [Showruncion]
= numberl_Callback
B& % —-—— Executes during object creat propertices.
87 Elfunition numberi CreatsFon (hobject numberl CreateFecn
ga =% hobjesct handle to numberl (se number?_Callback
geg % eventdata reserved - to be defi number?_CreateFcn n of MATLAE
=) % handies empty - handies not c pushbuttant Callback CreateFens called
91
82 % Hint: =dit controls usually havs raivRutianL-Cdlach Windows.
93 % Ses ISPC and COMPUTER. radicbutton?_Callback
94 — if ispc && isequal (get (hObject, 'Bas radicbutten3_Callback ,'defaultUicontrolBackgroundColor'))
83 = set (hCbject, 'BackgroundColor ', radiobuttond Callback
:i & e testl OpeningFen
o testl QutputFen
a2
100 function numberZ Callback (hCbject, eventdata, handles)
101 % nobiesce handle to numberZ (see GCEOD)
102 [% eventdata reserved - to be defined in a future version of MATLAB
103 % handles structure with handles and user data (See GUIDATA)
104
105 % Hints: get (hUbiject, 'String') returns contents of numberi as text
108 5 stridouble (get (hibject, 'String')) returns contents of numberiZ as g double

Flg 11. Accessing functions in *.m file

[

% ——— Executes just bhefore testl is made visible.
[Flfunction testl OpeningFen(hObject, eventdata, handles, varargin)

[-]% This function has no output args, see CutputFcn.

% hibject handle to figure
% eventdata reserved — to be defined in a future wversion of MATLAB
% handles structure with handles and user data (3ee GUIDATA)

- % Varargin command line arguments to testl (ses VARARGIN)

% Choose default command line output for testl
handles.output = hlbject;

% Update handles structure
guidata(hChiject, handles):

% UIVAIT makes testl wait for usser responss (ses UIRESUME)
% uiwait thandles.figurel):

cle

mowvegul | ' center! )

get (handles.radicbuttonl, 'Valus', 1):
set (handles.radiocbuttonZ, 'Valus', 0):
set (handles.radiobutton3, 'Valus', 0);
-set (handles.radiocbuttond, 'Valu=', 0):

Fig. 12. Opening function of simple calculator
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10. Programming Radio and Push Button

The radiobuttons should be mutually exclusive and when a radiobutton is selected
corresponding operating notation should be reflected in the symbol text box. This job is
done in the radiobutton callback function. One example (multiply radio button) is given in
Fig. 13. The Calculate (Push) button is also programmed as in Fig. 14.

.

% —— Executes on button press in radiobutton3.

|function radicbuttoni Callback (hCbjsct, sventdata, handles)
El% hobject handle to radichutton3 (ses GCBO)

% eventdata reserved — to be defined in a future version of MATLAB
handles structurs with handles and usser data (ss= GUIDATA

o

% Hint: get|h0hject;'Value') returns toggle state of radiobutton3
set (handles.radicbuttonl, 'Valu=', 0):
set (handles.radicbuttonz, 'Valus', 0);:
set (handles.radiobutton3, 'Valus', 1):
set (handles.radiocbutton4, 'Valu=s', 0);
-set (handles.textl, 'String', 'x'):

Fig. 13. Radio Button callback

% ——— Executes on button press in pushbuttonl.
1 function pushbuttonl Callback{hCbjesct, sventdata, handles)

hibject handle to pushbuttonl (sse GCBQ)

1%
% eventdata reserved - to be defined in a future version of MATLAR
% handles structures with handles and user data (Ies GUIDATA)
a = stridouble (get (handles.numberl, 'Scring')):
b= stridouble (get (handles.number2, 'Ztring'));
indexl = get (handles.radiocbuttonl, 'Valus');
index2 = get (handles.radicbuttonZ, 'Valus');
index3 = get {handles.radiocbutton3, 'Valus');
index4 = get (handles.radicbutton4, 'Valus');
if indexl==
c=ath;
else if indexi==1
c=a-k;
else 1f indexi==
c=ath;
else if indexd4==1
c=a/b;
end
end
end
end
set (handles.text3, 'String'.c):

Fig. 14. Push Button callback
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11. Running the GUI

If the GUI is completed programming and run (whole code is given later) the window
should look somewhat like Fig. 15 and if someone wants to multiply, the window will be
like Fig. 16.

' Bl testl I
@ ADD
10 + -15
= © SUBTRACT
L -5
o MULTIPLY
Calculate
| - DIVIDE
|

e —

Fig. 15. Running GUI for the first time

_n test] l-:l = —‘J_?-J ]

- ADD
5  x 10
- ~ © SUBTRACT
50
o @MULTIPLY
- DIVIDE

Fig. 16. Modifying and running GUI for multiplication
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12. Some Additional Tools

There are also some additional options to make the GUI more attractive. Two examples are
Object browser and Tab editor which are given in Fig. 17 and 18 respectively. The Object
Browser displays a hierarchical list of the objects in the figure. It can be opened from View >
Object Browser or by click the Object Browser icon on the GUIDE toolbar.

ﬁ untitled.fig |.E..._E_._S"§_|1
File  Edit ‘Wiew Layout Tools Help
Nodshasc sBbhd A6 >
yror—] | ‘ ‘ [OhiectErowser] | ‘ :
[ [#] Push Button ] | 1 | ADD 1

[ L [, .

e i | :
{ - { 10+ 15 ]
o | —— _ ‘=T —eSUBTRACT —|
[ Check Box I ‘ | 1 | | |
| F EditText || — -5 =
= = MULTIPLY
T8 Static Text ]
Calculate | | |
l =3 Pop-up Menu ] | e T L .
[ EH Listhox I | = DIVIDE
= i I i "

[ TOQQIE Buttan ] ﬁg Object Browser lﬂ@g
Bree o e
[ e Aues I -[El yicontral (numberl "107)
[ mEma ] -7 yicantrol (humber? "-15")
Tag: figurel [T yicontrol (text3 "-5")

=

-~ yicontrol (el " +")
- yicontrol (text2 "=")
-] yicontral (pushbuttonl "Calculate”)
- @ uicontrol (radicbuttonl "ADD™)
- @ uicontrol {radiobutton? "SUBTRACT™)
- @ uicontrol (radicbutton3 "MULTIPLY™)
- @ uicontral (radiobuttond "DIVIDE™)

|

A GUI's tab order is the order in which components of the GUI acquire focus when a user
presses the Tab key on the keyboard. Focus is generally denoted by a border or a dotted
border. To examine and change the tab order of the panel components, click the panel
background to select it, then select Tab Order Editor in the Tools menu of the Layout Editor.

1=

Fig. 17. Object browser
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The Tab Order Editor displays the panel's components in their current tab order. To change
the tab order, select a component and press the up or down arrow to move the component

up or down in the list.

74 untitled.fig

|| e e |

A 02X, Workspace

File Edit View Layout Tools Help r“ . . .
e TS T e | 4\ Tab Order Editor . =
NEW$BB9c [ sBhd A% b j pate :
: : : =l 1
& Select ‘ ‘ | | ‘ FF uicontrol (numberl "107
1 'ADD : | |®F vicontral (number2 "-157)
| ! | 1 | ‘ uicontral (pushbuttanl "Calculate")
— _ 10 | + -15_. I @ uicontrol (radiobuttonl "ADD")
@ - ——0 SUBTRACT || @ uicontrol (radiobuttan2 "SUBTRACT")
‘ | | ‘ @ uicontral (radiobutton3 "MULTIPLY")
| -5 | ® uicontrol (radiobuttond "DIVIDE")
e [ O MULTIPLY
|
Calculate | |
El Listhox ‘ = DIVIDE
i I |
| o '
iCﬁAxes 1 T — —
e Al ~-matlabroot
Tag: figurel Current Point: [202, 12] Position: [520, 4949, 402, 301] Fdie

Fig. 18. Tab editor

13. Running GUI from a Single *.m File

Up to this point to run a GUI, both *.fig and *.m files are required. A GUI can also run from
a single *.m file which will be demonstrated here. At first go to the testl.fig file in the
GUIDE and select Export from the File menu as depicted in Fig. 19. Let’s save the GUI in the
name ftest_standard.m.

wif test]. fig
GIEN Edit  Wiew Layout Tools Help

Hewr... cell B BB Ba 24
Cpen... Chrl+O A
Close Chrl+w o ADD
Save As...
-15
ot © SUBTRACT
Freferences..,
Print. .. Chrl+FP o) M ULTI PLY
1 Cih... 7\Desktopltestt fig late
© DIVIDE
Taq: figurel b Current Point: [25, 259] Position; [520, 541, 404, 260{

Fig. 19. Running GUI from a single *.m file
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14. Standalone Application Project

In this final step, the standalone project will be developed. Enter deploytool in the MATLAB
command window (It may be needed to setup the MATLAB compiler by entering
mbuild -setup and following steps in the command window). The MATLAB development
project window appears as in Fig. 20. Clicking the new deployment project icon as shown in
Fig. 20 opens a window as in Fig. 21.

J MATLAB 7.B.0 (R2009a)
File Edit Tools Project Debug Parallel Deskbop  Window Help

hﬂ lﬁ * % @l ) u mﬁ‘ ﬂ (7] CurrentDirectory:lC:'l,Documents and Settingshz:
Shortcuts (2] How to Add (2] What's Mew

illl=] JL i Bk @ w|?

|Create a new deployment project |

‘Welcome to the Deployment Tool

To get started, do any of the following:

@ Click the New Deployment Project icon Tin the Deployment Tool toolbar.
& Click the Open Deployment Project icon & to open an existing project.
# Click the Help icon 2 in the toothar.

Uze the Deployment Tool to perform these tagks:

Create a

project =  Add files ] Build —= Package

Fig. 20. Deployment tool

Here the project needs to be saved (let’s save it by the name fest_project.prj). After that, files
should be added to the project (here test_standard.m) which is given in Fig. 22. The state of
the deployment tool window after the file have been added is shown in Fig. 23. The next
step is to build the project which is given in Fig. 24. After the compilation process the
executable file will be available. The file can be found in the specified location in the distrib
folder. In this project the file name should be test_project.exe. If the file is clicked in any PC it
will run as in Fig. 25.
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¢ New Deployment Project

ATLAB Compiler
IATLAB Builder ME
IATLAB Builder 14

i Shared Library

I‘_ £
¥ C++ Shared Library

Mame !testjmjectpri |

Location |C:1DncumentsandSettlngsleSlE‘}WlDesktnp ‘ [ Browse... ]

| oK Cancel Help

Fig. 21. New deployment project window

J MATLAB 7.8.0 (R2009a)

File Edit Tools Project Debug Parallel Desktop  ‘Window  He

DB|* ‘."@|u@@|@.-|CurrentDire

Shortcuts [A] How to Add (2] What's New

|DeplnymentTnnl
NogE RO x |2 &aw|?

kest_project (StanAalona aoplication)|
&dd File

w7 Main Funckion
|2 other Files
L G+ Files

Fig. 22. Adding file to deployment tool

J MATLAB 7.8.0 (R2009a)

File Edit Tools Project Debug Parallel Deskbop  Window

EDEl*‘."@|h@@|@r|&lrrentl

Shortcuts [A] How to Add (2] What's Mew

DSd RO x|Bl&aw|?
kest_project (Standalone Application)|

=1 Main Function

ﬂ test_standalone.m

(7] Cther Files

[ CfC++ Files

Fig. 23. Deployment tool window after adding file
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Fig. 25. Running the standalone project

15. Conclusion

A standalone MATLAB project is discussed here which will be very useful for educational
purposes. Students can develop their projects in home and demonstrate in the class.
Teachers can build excellent software packages in powerful computers and without can run
it the classroom PCs with limited resource. There is no need of version compatibility, no
need of huge memory requirement. After completing the project in this chapter it will open
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a new horizon for MATLAB users. For first time users codes are given in the next article. In
case of any question regarding this issue the author can be contacted at
nasiruzzaman@ieee.org.

16. MATLAB Code

function varargout = testl(varargin)

% TEST1 M-file for testl.fig

%  TEST1, by itself, creates a new TEST1 or raises the existing

%  singleton®*.

%

%  H=TEST1 returns the handle to a new TEST1 or the handle to

%  the existing singleton*.

%

%  TEST1('CALLBACK'hObject,eventData,handles,...) calls the local

%  function named CALLBACK in TEST1.M with the given input arguments.
%

%  TEST1('Property','Value',...) creates a new TEST1 or raises the

%  existing singleton*. Starting from the left, property value pairs are

%  applied to the GUI before testl_OpeningFcn gets called. An

%  unrecognized property name or invalid value makes property application
%  stop. All inputs are passed to testl_OpeningFcn via varargin.

%

%  *See GUI Options on GUIDE's Tools menu. Choose "GUI allows only one
%  instance to run (singleton)".

%

% See also: GUIDE, GUIDATA, GUIHANDLES

% Edit the above text to modify the response to help testl
% Last Modified by GUIDE v2.5 28-May-2010 22:04:08

% Begin initialization code - DO NOT EDIT

gui_Singleton =1;

gui_State = struct('gui_Name', mfilename, ...
'gui_Singleton', gui_Singleton, ...
'gui_OpeningFcn', @testl_OpeningFen, ...
'gui_OutputFcn', @testl_OutputFen, ...
'gui_LayoutFcen!, [], ...
'gui_Callback', []);

if nargin && ischar(varargin{1})

gui_State.gui_Callback = str2func(varargin{1});
end

if nargout
[varargout{l:nargout}] = gui_mainfcn(gui_State, varargin{:});
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else

gui_mainfen(gui_State, varargin{:});
end
% End initialization code - DO NOT EDIT

% --- Executes just before test1 is made visible.

function testl_OpeningFcn(hObject, eventdata, handles, varargin)

% This function has no output args, see OutputFcn.

% hObject handle to figure

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% varargin command line arguments to testl (see VARARGIN)

% Choose default command line output for testl
handles.output = hObject;

% Update handles structure
guidata(hObject, handles);

% UIWAIT makes test]l wait for user response (see UIRESUME)
% uiwait(handles.figurel);

cle

movegui('center')
set(handles.radiobuttonl, 'Value', 1);
set(handles.radiobutton2, 'Value', 0);
set(handles.radiobutton3, 'Value', 0);
set(handles.radiobutton4, 'Value', 0);

% --- Outputs from this function are returned to the command line.
function varargout = testl_OutputFen(hObject, eventdata, handles)

% varargout cell array for returning output args (see VARARGOUT);
% hObject handle to figure

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Get default command line output from handles structure
varargout{1} = handles.output;

function numberl_Callback(hObject, eventdata, handles)
% hObject handle to number] (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB
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% handles structure with handles and user data (see GUIDATA)

% Hints: get(hObject,'String') returns contents of number1 as text
% str2double(get(hObject,'String')) returns contents of number1 as a double

% --- Executes during object creation, after setting all properties.
function numberl_CreateFen(hObject, eventdata, handles)

% hObject handle to number] (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB

% handles empty - handles not created until after all CreateFcns called

% Hint: edit controls usually have a white background on Windows.

%  See ISPC and COMPUTER.

if ispc && isequal(get(hObject, BackgroundColor'),

get(0,'defaultUicontrolBackgroundColor'))
set(hObject,'BackgroundColor','white');

end

function number2_Callback(hObject, eventdata, handles)

% hObject handle to number2 (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Hints: get(hObject,'String') returns contents of number?2 as text
% str2double(get(hObject,'String')) returns contents of number2 as a double

% --- Executes during object creation, after setting all properties.
function number2_CreateFcn(hObject, eventdata, handles)

% hObject handle to number2 (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB

% handles empty - handles not created until after all CreateFcns called

% Hint: edit controls usually have a white background on Windows.
%  See ISPC and COMPUTER.

if ispc && isequal(get(hObject,'BackgroundColor'),

get(0,'defaultUicontrolBackgroundColor'))
set(hObject,'BackgroundColor','white');
end

% --- Executes on button press in pushbuttonl.
function pushbutton1_Callback(hObject, eventdata, handles)
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% hObject handle to pushbuttonl (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)
a = str2double(get(handles.numberl, 'String'));
b= str2double(get(handles.number2, 'String'));
index1 = get(handles.radiobutton1, 'Value');
index2 = get(handles.radiobutton2, 'Value');
index3 = get(handles.radiobutton3, 'Value');
index4 = get(handles.radiobutton4, 'Value');
if index1==1
c=a+b;
else if index2==1
c=a-b;
else if index3==1
c=a*b;
else if index4==1
c=a/b;
end
end
end
end
set(handles.text3, 'String',c);

% --- Executes on button press in radiobuttonl.

function radiobutton1_Callback(hObject, eventdata, handles)

% hObject handle to radiobuttonl (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Hint: get(hObject,'Value') returns toggle state of radiobuttonl
set(handles.radiobuttonl, 'Value', 1);

set(handles.radiobutton2, 'Value', 0);

set(handles.radiobutton3, 'Value', 0);

set(handles.radiobutton4, 'Value', 0);

set(handles.textl, 'String', '+');

% --- Executes on button press in radiobutton?2.

function radiobutton2_Callback(hObject, eventdata, handles)

% hObject handle to radiobutton2 (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Hint: get(hObject,'Value') returns toggle state of radiobutton2
set(handles.radiobuttonl, 'Value', 0);
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set(handles.radiobutton2, 'Value', 1);
set(handles.radiobutton3, 'Value', 0);
set(handles.radiobutton4, 'Value', 0);
set(handles.textl, 'String’, '-');

% --- Executes on button press in radiobutton3.

function radiobutton3_Callback(hObject, eventdata, handles)

% hObject handle to radiobutton3 (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Hint: get(hObject,'Value') returns toggle state of radiobutton3
set(handles.radiobutton1, 'Value', 0);

set(handles.radiobutton2, 'Value', 0);

set(handles.radiobutton3, 'Value', 1);

set(handles.radiobutton4, 'Value', 0);

set(handles.textl, 'String', 'x');

% --- Executes on button press in radiobutton4.

function radiobutton4_Callback(hObject, eventdata, handles)

% hObject handle to radiobutton4 (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Hint: get(hObject,'Value') returns toggle state of radiobutton4
set(handles.radiobuttonl, 'Value', 0);

set(handles.radiobutton2, 'Value', 0);

set(handles.radiobutton3, 'Value', 0);

set(handles.radiobutton4, 'Value', 1);

set(handles.textl, 'String', '/");

% --- Executes on slider movement.

function slider1_Callback(hObject, eventdata, handles)

% hObject handle to slider] (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% Hints: get(hObject,'Value') returns position of slider

% get(hObject,'Min') and get(hObject,'Max') to determine range of slider

% --- Executes during object creation, after setting all properties.
function sliderl_CreateFcn(hObject, eventdata, handles)
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% hObject handle to slider] (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB
% handles empty - handles not created until after all CreateFcns called

% Hint: slider controls usually have a light gray background.

if isequal(get(hObject, BackgroundColor'), get(0,'defaultUicontrolBackgroundColor'))
set(hObject,'BackgroundColor',[.9 .9 .9]);

end
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